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Welcome!

Printing with your EPSON Stylus® C42 printer is easy, friendly, and fast. Simple 
enough for even the most inexperienced user, the Stylus C42 prints everything from 
school reports to family photos with great results.

For added value, it supports a wide range of EPSON® special media, including 
Glossy Photo Greeting Cards, Photo Stickers,® and special photo papers in a variety 
of sizes and finishes. Visit the EPSON Store at www.epsonstore.com for a complete 
list.

It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer software. Visit http://support.epson.com. 
Download instructions are posted for your convenience.

About Your Documentation

To set up your printer and install your Windows® XP or Macintosh® software, see the 
Start Here sheet.

To install your Windows 98, Me, or 2000 printer software, see the Installing Software 
for Windows 98, Windows Me, and Windows 2000 booklet. This booklet also contains 
safety instructions, your printer warranty, and other important information.

This online manual contains information about:

� Printing with Windows or on a Macintosh 

� Maintaining the printer

� Solving basic problems

� System requirements and printer specifications

SM
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Warnings, Cautions, Notes, and Tips

Please follow these guidelines:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain additional hints for better printing.
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Printing From Start to Finish

Before you start, make sure your printer software is installed as described on the Start 
Here sheet or Installing Software for Windows 98, Windows Me, and Windows 2000 
booklet.

No matter what you print, you need to remember two things:

� Use the right paper.
For the best-looking photos, most vivid colors, and sharpest text, always use 
EPSON ink jet papers. 

� Choose the right Paper Type setting (Media Type setting on the Macintosh).
Your printer automatically adjusts itself for each type of paper. That’s why this 
setting is important. It tells your printer what kind of paper you’re using. So 
remember to check your Paper Type setting every time you print. If you’re not 
sure which setting to use with your paper, see page 22.

Follow the instructions in these sections:

� Loading Paper on page 8

� Printing in Windows on page 9

� Printing on a Macintosh on page 13

� Printing on Envelopes on page 20

� Selecting the Correct Paper Type on page 22
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Loading Paper

Make sure your printer and computer are turned on.

1. Place your paper against the right edge of the sheet feeder, behind the tab.

2. Press in the locking tab on the left edge guide and slide it against the paper. 

3. Pull out the output tray extension.

Follow these guidelines when loading paper:

� Always load the short edge first, even when you’re printing landscape oriented 
documents.

� Load the printable side face up. It’s usually whiter or brighter than the other side.

� Load letterhead or preprinted paper into the printer top edge first.

� Don’t load paper above the arrow on the left edge guide.

� Load the following media types one sheet at a time: Photo Quality Self Adhesive 
Sheets, Photo Stickers,, and Panoramic Photo Paper.

� If you’re using special media, follow the instructions that came with the media.

Load paper 
behind the tab

Press the locking 
tab and slide the 
left edge guide 
against the paper
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Printing in Windows

Here’s what to do to print a basic document—such as a newsletter or school project. 
Make sure you have paper in the printer, as described on page 8. After you create your 
document in a software program, follow these steps to print. 

1. From the File menu, click Print. You see a Print window (your window may look 
different):

2. Make sure EPSON Stylus C42 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next screen.)

Click here to 
open your printer 
software

Select your printer here
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You see your printer Properties (or Preferences) window.

4. Select the type of document you’re printing:

� Draft: For rough drafts on plain paper. Saves ink.

� Text: For text-only documents, like letters or reports. Delivers high-quality 
text printing.

� Text & Image: For documents that have both text and images, like newsletters.

� Photo: For photos and graphics, when you want good quality with faster 
printing.

� Photo RPM: For photos or graphics, when you need highest quality printing. 
Because this setting increases resolution, it also increases print time.

5. Load the right paper for your document. See page 8 for loading instgructions.

1 Choose your 
document type

2 Choose your 
paper type . . .

3 and paper size

4 Click here
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6. If you loaded special paper, choose the correct 
paper type (click the arrow to scroll through the 
Type list). If you’re not sure which setting to 
select, see page 22.

7. Select your paper size (click on the arrow to 
scroll through the Size list).

8. If necessary, select your page orientation: 
Portrait for documents that are longer than they 
are wide, or Landscape for documents that are wider than they are long.

9. You can also make these settings:

� Photo Enhance: Improves the appearance of low-resolution and improperly 
exposed photos. Does not work when Black Ink Only is selected.

� ICM (Image Color Matching): Matches colors on your printout as closely as 
possible to the colors you see using ICM-compatible monitors or scanners.

� Black Ink Only: Prints using only black ink.

� Reverse Order: Prints your document so that the pages are in the right order 
when you retrieve them from the paper tray.

� Print Preview: Lets you see what your printout will look like before you print.

For more information about printer settings, click the Help button, or 
right-click any item on the screen and then click What’s This?.

10. Click OK to return to the Print window. Then click OK (or Print) to start printing.
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After a moment, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or restart printing. You can also see how much 
ink you have left. 

When you’re finished using your printer, make sure you press the

 

P power button to turn it off. Never use a power strip or external switch 
to turn off the printer.

Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you usually 
print one type of document in different programs—for example, color photos on 
letter-size paper—you can change the default printer settings for all your programs. 

1. Right-click the  printer icon on your taskbar (in the lower right corner of your 
screen). 

2. Select Printer Settings. You see your printer Preferences (Properties) window, as 
shown on page 10.

3. Select the default settings you want to use for all your applications. Click OK 
when you’re finished.

Remember that you can always change the settings in your program when you want to 
print different types of documents.

Click to cancel printing

Click to pause or resume printing
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Printing on a Macintosh

This section explains how to use your EPSON Stylus C42 to print from a Macintosh 
running either OS X or OS 8.5.1 to 9.x.

Macintosh OS X

Here’s how to print a basic document, such as a newsletter or school project, if your 
Macintosh is running OS X. Make sure you have paper in the printer, as described on 
page 8. After you create your document, follow these steps to print.

If you’re using an application that’s compatible only with Macintosh 
Classic mode, follow the steps on page 17 to print your document.

1. From the File menu, select Page Setup. You see a screen like this:

2. Select your printer from the Format for menu.

3. Select the Paper Size, Orientation, and any other settings you want to use and 
click OK.

Select your printer 
from the Format for 
pop-up menu
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4. Select Print from the File menu. You see a screen like this:

5. Select Print Settings from the pull-down menu. You see a group of settings like 
this:

Click here and select 
Print Settings

Select the type of 
paper you loaded

Select the ink color

Select Automatic mode

Select higher quality 
or faster printing, or 
an in-between setting 
(if available)

Click Print
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6. Select the following settings:

� Load the right paper for your document in the printer. If you loaded special 
paper, choose the correct paper type in the Media Type list. If you’re not sure 
which setting to choose, see page 22.

� Set the Ink option to Color to print a color document. To print a black text 
document, click Black.

� Set the Mode option to Automatic. It’s the easiest way to get good printing 
results for most projects.

� Set the slider to Quality or Speed to select high-quality printing, faster 
printing, or an in-between setting (if available). (The slider may not be 
available for some paper types.)

7. To select a specific print quality setting, click Advanced Settings and choose a 
setting from the Print Quality menu:

� Economy or Economy Plus, for printing drafts. Saves ink. (Economy Plus is 
only available if you select Black as the ink color.)

� Normal, for everyday printing needs

� Fine, when you want a higher resolution for printing text or text and graphics

� Photo, when you’re printing photographs

� Photo RPM, when you want the highest resolution for your photographs and 
you don’t mind the longer print time.

8. You can also choose other print settings by selecting these options in the 
pull-down menu:

� Copies & Pages, to select the number of copies or a page range

� Layout, to select page layout options

� Output Options, to save your print job as a PDF file

� Color Management, to select ColorSync® or adjust the color controls or 
gamma setting

� Summary, to view a list of all your selections

� Save Custom Setting, to save your selections for future use.
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9. When you’re ready to print, click Print. The Print Center icon appears in the dock 
on the bottom of your desktop.

If you click the Print Center icon and then double-click the C42 Series (USB) icon in 
the Printer List, you see a screen like this:

From here you can monitor the progress of your print job or do one of the following:

� Click the print job, then click Delete to delete it

� Click the print job, then click Hold to pause printing

� Click a print job marked “Hold” and click Resume to resume printing

� If multiple print jobs are listed, click a print job, then click the Priority arrow to 
reorder the jobs.

When you’re finished using your printer, make sure you press the

 

P power button to turn it off. Never use a power strip or external switch 
to turn off the printer.

Click to 
reorder 
print jobs

Select a print 
job, then . . .

click a button to 
Delete, Hold 
(pause), or 
Resume printing
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Macintosh OS 8.5.1 to 9.x

Here’s what to do to print a basic document—such as a newsletter or school project—
if your Macintosh is running OS 8.5.1 to 9.x. Make sure you have paper in the 
printer, as described on page 8. After you create your document, follow these steps to 
print. 

1. From the File menu, select Page Setup. You see the following:

2. Make sure C42 Series is selected. 

If not, you need to select your printer in the Chooser.

3. Select the correct Paper Size, Orientation, and other settings. Then click OK.

For more information about printer settings, click the ? button.

4. From the File menu, select Print. You see a window like the following:

Make sure you see 
C42 Series

Select your paper size

Select the orientation 
of your document

Select higher quality or faster printing

Select the type of 
paper you loaded

Select Automatic mode

Select the 
ink color
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5. Make the following settings:

� Choose the paper you’re printing on (click the arrow to scroll through the 
Media Type list). If you’re not sure which setting to select, see page 22. 

� Set the Ink option to Color to print a color document. To print a black text 
document, click Black.

� Set the Mode option to Automatic. It’s the easiest way to get good printing 
results on all types of paper.

� Set the slider in the Mode box to Quality or Speed to select high-quality 
printing, faster printing, or an in-between setting.

6. You can also do the following:

� Click  to reduce or enlarge your image, print multiple layouts, or add a 
watermark.

� Click  to turn on background printing. 

� Click  to change the Print button to Preview. You can then click it to 
preview your printout.

� Click  to check your ink levels. If the red 

 

b error light is on or flashing, 
check to see if one of your ink cartridges is low or empty.

� Click PhotoEnhance to improve the appearance of low-resolution and 
improperly exposed photos. Only works when Color ink is selected. 

� Click Custom, and then select ColorSync to match the colors in your printout 
as closely as possible to those you see using ColorSync-compatible devices and 
applications.

� Click Custom, and then click the Advanced button that appears to select a 
specific setting for print quality or to change color management settings. 

Print Quality settings include Economy and Economy Plus for draft printing, 
Normal for everyday printing needs, Fine when you want a higher resolution 
for text or text and graphics, Photo when you’re printing photographs, and 
Photo RPM when you want the highest resolution for your photographs and 
don’t mind the longer print time.
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7. Click Print to start printing. If you turned on background printing, you can select 
EPSON Monitor3 from the Macintosh Application menu to see this dialog box:

If you’re not using background printing and you need to cancel printing, 
hold down the 

 

J key and press the . (period) key.

When you’re finished using your printer, make sure you press the

 

P power button to turn it off. Never use a power strip or external switch 
to turn off the printer.

Click to cancel printing Click to check ink levelsClick to pause printing

Click to restart your print job

Click on the 
current print job 
or 
a waiting print 
job . . .

Then click here to 
view details of the 
selected print job 
and control print 
job prioritities
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Printing on Envelopes

You can load up to 10 envelopes at a time. Follow these steps to print on No. 10 size 
envelopes:

1. Load the envelopes short edge first against the right edge of the sheet feeder, 
behind the tab. The printable side should be up, and the flap side should be down 
and on the left. 

2. Press in the locking tab on the left edge guide and slide it against the envelopes.

3. In your application software, set a left margin of approximately 3 inches. Set a top 
margin of approximately 2 inches. Then type the address.

4. Open your printer software and make the following settings:

� For Paper Type (Windows) or Media Type (Macintosh), select Plain Paper

� For Orientation, select Landscape

� For Paper Size, select Envelope #10 (4 1/8 × 9 1/2 in) (Windows and 
Macintosh OS X) or Envelope #10 (Macintosh OS 8.5.1 to 9.x).

Load the printable 
side up and the flap 
side down



Printing From Start to Finish 21

5. Do one of the following to view a preview of your envelope:

Windows: Click the Print Preview box, then click OK to close your Preferences 
(Properties) window. Click Print on the Print window. 

Macintosh OS X: Click the Preview button on the Print Settings menu.

Macintosh OS 8.5.1 to 9.x: Click the  button on the printer settings menu. 
Then click the Preview button that appears.

6. If you need to change the margins, cancel or close the preview window and adjust 
the margins in your application software. Then repeat step 5.

7. When your preview looks okay, print the envelope:

Windows and Macintosh OS 8.5.1 to 9.x: Click the Print button on the Print 
Preview window.

Macintosh OS X: Select Print from your application software’s File menu. Then 
click the Print button on the window that appears.
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Selecting the Correct Paper Type

Your printer automatically adjusts itself for the type 
of paper you select in your print  settings. That’s why 
the Paper Type setting (Media Type setting in 
Macintosh) is so important. It tells your printer what 
kind of paper you’re using and adjusts the ink 
coverage accordingly.

The table below lists the settings you should choose 
for your paper:

For this paper . . . Select this Paper setting . . .

Plain paper sheets or envelopes

EPSON Premium Bright White Paper

Plain paper

EPSON High Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Glossy Photo Paper

EPSON Photo Paper

EPSON Photo Quality Glossy Paper

EPSON Glossy Photo Greeting Cards

Glossy Photo Paper

EPSON Photo Stickers

EPSON Photo Quality Glossy Film

Photo Quality Glossy Film

EPSON Ink Jet Transparencies Ink Jet Transparencies

EPSON Matte Paper Heavyweight

EPSON Double-Sided Matte Paper

Matte Paper - Heavyweight
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Maintaining Your Printer

This chapter describes maintenance procedures to keep your printer working at its 
best, and preparation steps for moving your printer. Follow the instructions here for: 

� Cleaning the Print Head below

� Replacing an Ink Cartridge on page 25

� Aligning the Print Head on page 29

� Cleaning the Printer on page 30

� Transporting the Printer on page 31

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing from the image, 
you may need to clean the print head. This unclogs the nozzles so they can deliver ink 
properly. 

Print head cleaning uses ink, so clean it only if quality declines. 

This section explains how to clean the print head using the Head Cleaning utility. 
This is the recommended method when the printer is connected directly to your 
computer (not over a network). 

You can also clean the print head by holding down the 

 

b maintenance button on the 
printer for three seconds (when the red 

 

b error light is off). 

When you don’t turn on your printer for a long time, the print quality can 
decline. It’s a good idea to turn on your printer at least once a month to 
maintain good print quality.
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Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red 

 

b error light is 
off. (If the red light is flashing or on, you may need to replace the ink cartridge; 
see page 25 for details.)

2. Do one of the following:

� Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

� Macintosh OS 8.5.1 to 9.x: Open the File menu and choose Page Setup or 
Print. Click the  Utility button, then click the  Head Cleaning button.

� Macintosh OS X: Double-click the Applications folder on your hard drive. 
Double-click EPSON Printer Utility, select the C42 Series printer in the 
Printer List window, and click OK. Then click the  Head Cleaning button.

3. Follow the instructions on the screen to clean the print head. Cleaning takes 
about 30 seconds, during which the printer makes some noise and the green 

 

P power light flashes. 

Never turn off the printer while the 

 

P power light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.

4. When the 

 

P power light stops flashing, run a nozzle check to confirm the print 
head nozzles are clean.

Make sure plain paper is loaded in the printer and click Print Nozzle Check 
Pattern. Then click Print. The nozzle check pattern prints (see the next section for 
details). 

5. If the nozzle check pattern has no gaps or lines, click Finish.

If the pattern has white lines, click Clean to clean the print head again. 

If you don’t see any improvement after cleaning three or four times, check the 
solutions beginning on page 38. You can also turn the printer off and wait 
overnight—this allows any dried ink to soften—and then try cleaning the print 
head again. 
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. 
Each colored square should be solid, with no 
gaps or lines, as shown:

� If your printout looks okay, you’re done. 

� If you see any white lines or gaps (as shown), 
clean the print head again; see page 24 for 
instructions. 

Replacing an Ink Cartridge

When the red 

 

b error light flashes, an ink cartridge is low on ink. This is a good time 
to make sure you have a new cartridge. When the red 

 

b error light stays on, you may 
need to replace one of the cartridges.

The red 

 

b error light also comes on if 
your paper runs out or is jammed, so 
make sure you check your paper before 
replacing a cartridge. 

To check your ink supply, do one of the 
following:

� Windows: Double-click the  printer 
icon on your taskbar (in the lower right 
corner of your screen). You’ll see a 
window like the one on the right 
showing the ink remaining in each 
cartridge. 

You can also double-click the  Ink Monitor icon on your taskbar. You see a 
window showing the amount of ink remaining. You can click the Buy Now 
button to launch your web browser and order ink cartridges online.
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� Macintosh OS 8.5.1 to 9.x: Open the File menu and choose Print. Click the  
ink icon. You see a window showing the ink remaining in each cartridge.

� Macintosh OS X: Double-click the Applications folder on your hard drive. 
Double-click EPSON Printer Utility, select the C42 Series printer in the Printer 
List window, and click OK. Then click the  EPSON StatusMonitor button. You 
see a window showing the ink remaining in each cartridge.

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if the 

 

b error light is off. 

Use these EPSON ink cartridges within six months of installing them and before the 
expiration date on the package:

� Black ink cartridge: T036120

� Color ink cartridge: T037020 

Look for ink cartridge packages labelled T036 (black) or T037 (color).

To ensure good results, use genuine EPSON ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered 
by EPSON’s warranty.

When you need new ink cartridges, contact your dealer or call EPSON at 
(800) 873-7766 or visit the EPSON Store at www.epsonstore.com (U.S. sales only). 
In Canada, please call (800) 463-7766 for dealer referral. 

Ink Cartridge Precautions

Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If 
ink gets in your eyes, flush them thoroughly with water.

To avoid damaging the printer, never move the print head (ink cartridge 
holders) by hand.

You cannot print if either ink cartridge is empty. Leave the empty cartridge 
installed in the printer until you have obtained a replacement. Otherwise 
the ink remaining in the print head nozzles may dry out.
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Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start the ink 
cartridge replacement procedure, you must complete all the steps in one session. 

1. Make sure the printer is turned on and not printing (the green 

 

P power light 
should be on, but not flashing). Then open the printer cover.

2. Press the 

 

( maintenance button for 
6 seconds. The print head moves to 
the cartridge replacement position.

3. Pull up the ink cartridge clamp and 
remove the cartridge. Dispose of it 
carefully.

4. Unpack the new cartridge and 
remove the yellow tab.

If both cartridges need replacing, the 
print head moves to the black 
cartridge position first.

The black cartridge is on the left, and 
the color cartridge is on the right.

Black 
cartridge

Color 
cartridge

Don’t touch the 
green chips

You must remove the 
yellow tape from the top of 
the cartridge or you will 
permanently damage it. 

Be careful not to touch the 
green chip on the front of 
the cartridge; you might 
damage the cartridge.
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5. Insert the new cartridge and press 
down firmly on the clamp. Make sure 
the clamp is closed completely.

6. Press the 

 

( maintenance button. 

If the other cartridge needs to be 
replaced, the print head moves into 
loading postion. Repeat steps 4 
through 6.

7. Wait until ink charging is finished. (The green 

 

P

 

 power light stops flashing and 
the red 

 

( error light goes out.) Ink charging takes about 30 seconds.

8. Close the printer cover.

Now you’re ready to print again. 

If the red 

 

( error light remains on and the printer continues to make noise for more 
than five minutes, open the printer cover and press the 

 

P

 

 power button to turn the 
printer off. Then make sure that the ink cartridge clamps are completely closed. Close 
the printer cover and press the 

 

( maintenance button to finish ink charging. If that 
doesn’t work, contact EPSON as described on page 46.

Maintenance 
button

Don’t move the print head 
by hand; you could damage 
the printer. Always use the 
( maintenance button.



Maintaining Your Printer 29

Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to align the print 
head. Your printer must be connected directly to your computer (not over a network) 
to use the Print Head Alignment utility. 

Load plain paper that’s at least 8.27 inches (210 mm) wide to prevent 
ink from spraying inside the printer and smudging your printouts. 

1. Make sure the printer is turned on, but not printing, and letter-size plain paper is 
loaded.

2. Do one of the following:

� Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen) and select Print Head Alignment.

� Macintosh OS 8.5.1 to 9.x: Open the File menu and choose Page Setup or 
Print. Then click the  Utility button. In the Utility menu, click the  
Print Head Alignment button.

� Macintosh OS X: Double-click the Applications folder on your hard drive. 
Double-click EPSON Printer Utility, select the C42 Series printer in the 
Printer List window, and click OK. Then click the  Print Head Alignment 
button.

3. Follow the instructions on the 
screen to print a test page. You see 
this window:

4. On the printed page, select the 
pattern that shows the two vertical 
lines most precisely printed on top 
of each other. You may need to use 
a magnifying glass.

Select one pattern each for rows 1, 
2, and 3. Then enter the number of 
the best pattern for each row in the 
corresponding boxes on the screen.
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5. Click Realignment to print another test page. Make sure the pattern numbered 8 
in each row is the best aligned. If not, repeat steps 4 and 5.

6. When you’re finished, click Finish. 

Cleaning the Printer 

To keep your printer working at its best, you should clean it several times a year. 

1. Turn off the printer and disconnect the USB cable and power cord.

2. Remove all paper, then use a soft brush to clean any dust or dirt from the sheet 
feeder.

3. Clean the exterior of the printer with a soft, damp cloth.

Never use a hard or abrasive brush, or alcohol or thinner for cleaning; 
they can damage the printer components and case. 

Don’t get water on the printer components and don’t spray lubricants or 
oils inside the printer. 

Don’t use any cleaning sheets included with special paper; they may 
jam inside the printer.
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Transporting the Printer 

If you move your printer some distance, you need to prepare it for transportation in 
its original box or one of a similar size. 

To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

Be sure to remove the tape used in step 4 after installing the printer in its 
new location.

1. Turn on the printer, wait until the print head (ink cartridge holders) locks in the 
far right position, then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then disconnect both the 
printer cable and the power cord from the printer.

3. Remove any paper from the printer and remove the paper support.

4. Open the printer cover. Secure the print 
head to the printer with tape as shown, then 
close the printer cover.

5. Push in the output tray.

6. Repack the printer and its attachments in the 
original box using the protective materials 
that came with them.

Keep the printer level as you transport it. 

After transporting the printer, remove the tape securing the print head and test your 
printer. If you notice a decline in print quality, clean the print head (see page 23); if 
output is misaligned, align the print head (see page 29). 

Tape the print 
head to the printer
case
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Solving Problems

This section gives you the basics for diagnosing and solving printer problems. 

First see “Diagnosing Printer Problems” on page 34 to help determine what the cause 
of the problem may be. Refer to the pictures on page 33 if you need help identifying 
parts of the printer.

It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

Then see these sections for solutions:

� Setup and Software Installation Problems on page 36

� Printer Problems on page 37

� Print Quality Problems on page 38

� Paper Feeding Problems on page 41

� Miscellaneous Printout Problems on page 42

� Reinstalling Printer Software on page 43

� Where To Get Help on page 46
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Printer Parts

Power button 
and light

Maintenance button 
and error light

Paper support

Printer cover

Output tray

Left edge guide

Print head (ink 
cartridge holders)
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Diagnosing Printer Problems

First, check the printer’s lights as described below, or run a printer check as described 
on page 35.

Lights Explanation

Green 

 

P power light 
flashes

The printer is receiving a print job, replacing an ink cartridge, 
charging ink, or cleaning the print head.

Red 

 

b error light is 
on

Your paper ran out, ink ran out, or paper is jammed. You may also 
see a message on your screen.

� If paper is out, load more paper, then press the 

 

b maintenance button to resume printing. 

� If paper is jammed, press the 

 

b maintenance button 
to eject the paper. If that doesn’t work, turn off the printer, 
open the cover, and pull the paper out from the front, including 
any torn pieces. Then turn on the printer, reload paper, and 
press the 

 

b maintenance button.

� If you see an ink out message on your screen, you need to 
replace one of your ink cartridges. Replace the cartridge as 
described on page 25.

Red 

 

b error light 
flashes

One of the ink cartridges is low. Make sure you have a replacement 
cartridge. To determine which cartridge is low, check the ink level 
as described on pages 25 and 26.

Green 

 

P power 
light is off and red 

 

b error light is on

Paper may be blocking movement of the print head. Turn off the 
printer, open the cover, and remove any jammed paper or other 
foreign objects. Then turn the printer on again. If the lights are still 
on, contact your dealer or EPSON; see page 46 for contact 
information.

Green 

 

P power light 
and red 

 

b error light

 

 
flash 

The printer may have an internal error. Turn off the printer, wait a 
few seconds, and turn it on again. If the lights are still flashing, 
contact your dealer or EPSON; see page 46 for contact information.

Green 

 

P power light 
and red 

 

b error

 

 light 
are on after installing 
an ink cartridge

One of your ink cartridges is installed incorrectly. Follow the 
instructions beginning on page 27 to remove and reinstall the 
cartridge.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
itself or some other source. The printer check also shows how much black and color 
ink you have left.

1. Make sure both the printer and computer are turned off. Then disconnect the 
USB cable from the printer.

2. Make sure letter-size or larger plain paper is loaded in the printer.

3. Hold down the 

 

b

 

 maintenance 
button, then press and release the 

 

Ppower button. Continue holding 
down the 

 

b

 

 maintenance button 
until the green 

 

P power light starts to 
flash, then release it.

The printer prints one page showing 
its ROM version number, the ink 
counter code, and a nozzle check 
pattern. (If the pattern has lines, you 
need to clean the print head; see 
page 23.)

4. Turn off the printer after it prints the check page. Then reconnect the cable and 
turn on your printer and computer.

� If the check page prints, the problem probably lies in your software settings, 
the USB cable, or your computer. It’s also possible that your software may not 
be installed correctly. See page 43 for instructions on reinstalling the printer 
software.

� If the check page doesn’t print, you may have a problem with your printer. 
Try the suggestions in “Problems and Solutions” beginning on page 36. If 
nothing works, contact your dealer or EPSON as described on page 46.
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Problems and Solutions

Setup and Software Installation Problems

The printer makes noise after ink 
cartridge installation.

� The first time you install ink 
cartridges, the printer must 
charge its print head for about 
90 seconds. Wait until charging 
finishes (the green 

 

P power 
light stops flashing) before you 
turn off the printer, or it may 
charge improperly and use 
excess ink the next time you 
turn it on. 

If the printer stops moving or 
making noise, but the green 

 

P power light is still flashing 
after 5 minutes, turn off the 
printer. If the light is still 
flashing when you turn it back 
on, contact EPSON as 
described on page 46.

� Turn off the printer, then make 
sure the ink cartridge clamps are 
locked down completely and no 
packing material remains in the 
printer. Wait a moment, then 
turn the printer back on to clear 
the error.

You’re having problems installing 
the printer software.

� Make sure your printer is turned 
on and the USB cable is securely 
connected at both ends. Then 
carefully follow the installation 
instructions on the Start Here 
sheet or the Installing Software 
for Windows 98, Windows Me, 
and Windows 2000 booklet. 
Also make sure your system 
meets the requirements starting 
on page 47.

� Close your other programs, 
including any screen savers and 
virus protection software, and 
install again.

� If you’re running Macintosh 
OS 8.5.1 to 9.x and your 
printer icon (C42 Series) 
doesn’t appear in the Macintosh 
Chooser, you may have too 
many items in the Chooser. 
Delete any unused items and 
check the Chooser again.
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� For Windows 2000, if you see 
an error message or your 
software doesn’t install 
correctly, you may not have 
software installation privileges. 
Contact your System 
Administrator.

� In Windows 2000 or XP, 
don’t select Block under Control 
Panel > System > Hardware > 
Driver Signing; select Ignore or 
Warn instead.

� Make sure your Windows 
system was not upgraded from 
Windows 95. The USB Printer 
Device Driver may not install 
correctly if you upgraded from 
Windows 95.

� Make sure the USB Controller 
is working properly in Device 
Manager. See your Windows 
help system for details. If it’s not 
working, contact your computer 
manufacturer.

Printer Problems

Only the

 

 green 

 

P power light is 
on, but nothing prints.

� Make sure the USB cable is 
connected securely and that the 
cable meets the requirements 
beginning on page 47.

� Run a printer check as described 
on page 35. If the check page 
prints, make sure your software 
is installed correctly. 

The printer sounds as though it is 
printing, but nothing prints.

� Make sure the print head 
nozzles are not clogged. To 
clean the print head, see 
page 23.

� The printer won’t operate 
properly if it’s tilted or at an 
angle. Place it on a flat, stable 
surface that extends beyond the 
printer base in all directions.
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Your printer makes noise when 
you turn it on or after it has been 
sitting for awhile.

Your printer is performing routine 
maintenance.

Printing is too slow.

Make sure your system meets the 
requirements listed on page 47 and 
page 48. If you’re printing a 
high-resolution image, you need 
more than the minimum 
requirements listed. You may also 
need to:

� Clear space on your hard drive 
or run a defragmentation utility.

� Close programs that you’re not 
using.

� Increase your system’s memory.

For the fastest printing, try these 
tips:

� Choose black ink in your 
printer software if your 
document doesn’t include color.

� For Windows, choose Draft for 
Quality Type.

� For Macintosh, set the 
Quality/Speed slider to Speed.

� If your printer is connected to a 
hub, disconnect unused USB 
devices.

Print Quality 
Problems

You see banding (light lines).

� The print head nozzles may 
need cleaning; see page 23 for 
instructions. 

� Make sure the Paper Type 
setting (Media Type setting for 
Macintosh) matches the paper 
you loaded; see page 22 for 
guidelines.

� Make sure the printable side of 
the paper is face up. It’s usually 
whiter or shinier.

� The ink cartridges may need 
replacing. To replace an ink 
cartridge, see page 25.

� If you have a Macintosh, try 
using Automatic mode. See 
page 14 (Macintosh OS X) or 
page 17 (Macintosh OS 8.5.1 to 
9.x) for instructions.
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� Run the Print Head Alignment 
utility; see page 29 for 
instructions.

Your printout is blurry or 
smeared.

� Make sure your paper isn’t 
damp or curled, or loaded face 
down (the printable side should 
be face up).

� Use a support sheet with special 
paper, or try loading your paper 
one sheet at a time.

� Use EPSON papers to ensure 
proper saturation and 
absorption of genuine EPSON 
inks. 

� Run the Print Head Alignment 
utility. See page 29 for 
instructions.

Your printout is faint or has gaps.

� The print head nozzles may 
need cleaning; see page 23 for 
instructions. 

� The ink cartridges may be old or 
low on ink. To replace an ink 
cartridge, see page 25. 

� Make sure the Paper Type 
setting (Media Type setting for 
Macintosh) matches the paper 
you loaded. See page 22 for 
guidelines.

� Make sure your paper isn’t 
damaged, old, dirty, or loaded 
face down. If it is, reload a new 
stack of paper with the printable 
side up; it is usually whiter or 
shinier than the other side.
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You see wrong or missing colors.

� Make sure your printer software 
is not set to use black ink only.

� The print head nozzles may 
need cleaning; see page 23 for 
instructions.

� The ink cartridges may be old or 
low on ink. To replace an ink 
cartridge, see page 25.

� Try turning off PhotoEnhance. 

� For Macintosh, try using 
Automatic mode.

� For Macintosh, try changing the 
Gamma setting; see page 18 for 
instructions on accessing the 
Advanced window (Macintosh 
OS 8.5.1 to 9.x), or page 15 to 
access the Color Management 
window (Macintosh OS X).

� Your printed colors can never 
exactly match your on-screen 
colors. However, you can use a 
color management system to get 
as close as possible. Try using 
the ICM (Windows) or 
ColorSync (Macintosh) setting. 

Your printout is grainy.

� Try using a higher quality 
paper.

� Select Photo RPM for Quality 
Type (Windows) or Print 
Quality (Macintosh). 
Remember that this setting 
increases print time.

� Run the Print Head Alignment 
utility. See page 29 for 
instructions.

� You may need to increase the 
image resolution or print it in a 
smaller size; see your software 
documentation.



Solving Problems 41

Paper Feeding 
Problems

Paper doesn’t eject fully or is 
wrinkled.

� If the paper doesn’t eject fully, 
you may have set the wrong 
paper size. Press the 

 

b

 

 
maintenance button to eject the 
paper, and then select the 
correct paper size.

� If it’s wrinkled when it ejects, 
the paper may be damp or too 
thin. See page 51 for paper 
specifications.

Paper doesn’t feed correctly or 
jams in the printer.

� If paper doesn’t feed, remove it 
from the sheet feeder. Reload it 
against the right edge, behind 
the tabs, then slide the left edge 
guide against the paper.

� If multiple pages feed at once, 
remove the paper from the sheet 
feeder, fan the edges to separate 
the sheets, then reload it.

� If paper jams, press the 

 

b maintenance button for 
several seconds to clear the jam. 
If that doesn’t work, open the 
cover and pull the paper out 
from the front, including small 
pieces that may have torn off. 
Reload the paper and press the 

 

b maintenance button.

If your paper loads incorrectly or 
jams frequently:

� Use new, smooth, high-quality 
paper, loaded printable side up.

� Fan the edges of the stack of 
paper to separate the sheets.

� Don’t load paper above the 
arrow mark inside the left edge 
guide.

� Place the paper against the right 
edge behind the tab. Slide the 
left edge guide against it, but 
not too tightly. 
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Miscellaneous 
Printout Problems

The image is inverted, as if viewed 
in a mirror.

� Turn off the mirror setting in 
your application program. 

� For Macintosh, turn off Flip 
Horizontal in the Advanced 
window of your printer driver 
(Macintosh OS 8.5.1 to 9.x) or 
Print Settings window 
(Macintosh OS X).

The printer prints blank pages.

� Make sure your printer is 
selected in Windows. For 
Macintosh OS X, open the 
Print Center and make sure 
your printer is selected in the 
Printer List. For Macintosh 
OS 9.x or earlier, make sure 
your printer is selected in the 
Chooser.

� The print head nozzles may 
need cleaning. See page 23. 

The margins are incorrect.

� Make sure the paper settings are 
correct for your paper size. For 
instructions, see page 11 
(Windows), page 13 
(Macintosh OS X), or page 17 
(Macintosh 8.5.1 to 9.x).

� Use the Print Preview option in 
your printer software to check 
your margins before you print.

� Make sure your paper is 
positioned next to the right side 
of the feeder.

You see incorrect characters.

� Make sure the USB cable is 
securely connected and meets 
the system requirements on 
page 47. Then try printing 
again.

� Make sure your printer is 
selected in your software, or is 
set as the active printer in the 
Macintosh Chooser (OS 8.5.1 
to 9.x) or Print Center (OS X). 

� If you’re using a switch box or 
USB hub with your printer, 
connect the printer directly to 
your computer.
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Reinstalling Printer Software 

You don’t need to uninstall your printer software unless you have a Macintosh 
running OS 8.5.1 to 9.x. 

Windows

You can reinstall your printer software over your currently installed printer software. 
Make sure the printer is connected to your computer, then follow these steps:

1. Turn the printer on. Then insert the EPSON CD-ROM in your drive. If you see 
the Options Menu, go to step 4.

If you don’t see the Options Menu, continue with step 3.

2. Windows XP: Click Start, then click My Computer. Double-click  EPSON. 
You see the Options Menu.

Other Windows systems: Double-click My Computer on your desktop, and then 
double-click  EPSON. You see the Options Menu.

3. Click Reinstall Printer Driver. Then follow the instructions on the screen to 
reinstall your driver.

4. Click Exit to close the Options Menu.

Click here
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Macintosh OS 8.5.1 to 9.x

Follow these steps to uninstall your printer software:

1. Insert your printer software CD-ROM. 

2. Double-click the EPSON CD-ROM icon (if necessary) and double-click the
 EPSON icon. The Main Menu appears.

3. Click Install Printer Driver. On the installer screen, click the arrow in the Easy 
Install list at the top and select Uninstall. Then click the Uninstall button at the 
bottom and follow the instructions.

4. Restart your Macintosh, then follow the instructions on the Start Here sheet to 
reinstall your software.

Macintosh OS X

You can reinstall your printer software over your currently installed printer software. 
Follow these steps:

1. Insert the EPSON CD-ROM in your drive.

2. Double-click the EPSON CD-ROM icon, and then double-click the 
C42Series file.
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3. If you set up an administrator password when you installed OS X, you see this 
screen:

Click the  lock icon, enter your administrator password, and click OK. At the 
next screen, click Continue.

4. Read the license agreement and click Continue. Then click Agree.

5. Select the OS X drive where you want to reinstall your printer software, then click 
Continue.

6. Click Upgrade on the Easy Install screen, and follow the on-screen instructions to 
install the printer softtware and restart your Macintosh.

Lock icon
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Where To Get Help

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed below:

You can purchase ink cartridges, paper, manuals, and accessories from EPSON at 
(800) 873-7766, or visit the EPSON Store at www.epsonstore.com (U.S. sales only). 
In Canada, please call (800) 463-7766 for dealer referral.

Service Access

World Wide 
Web

From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download drivers 
and other files, look at product documentation, access 
troubleshooting information, and receive technical advice through 
e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, 
seven days a week. To use these services, you must have a touch 
tone telephone and call (800) 922-8911. Your SoundAdviceSM 
Express Code is 70370. Use this code to quickly select the EPSON 
Stylus C42 in SoundAdvice.
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Requirements and Specifications

This chapter includes system requirements and printer specifications.

Windows System Requirements

To use your printer and its software, your system should have: 

� A Microsoft® Windows compatible PC with a Pentium®-equivalent processor 
(233 MHz or faster recommended) 

� Microsoft Windows XP, Windows Me, Windows 2000, or Windows 98

� At least 64MB RAM (128MB recommended)

� 100MB free hard disk space (200MB or more recommended)

� VGA or better display adapter and monitor

� 2x CD-ROM or DVD drive for installing the printer software (4x or faster 
recommended)

� A shielded USB “AB” cable up to 6.5 feet (2 meters) long.
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Macintosh System Requirements

To use your printer and its software, your system should have: 

� An Apple® iMac™ series or Power Macintosh® G3 or G4 with built-in USB port

� Macintosh OS 8.5.1 through OS X. (Macintosh OS 9.0 or later recommended)

� At least 32MB RAM for OS 8.5.1 through OS 9.x (64MB recommended); 
128MB RAM recommended for OS X

� At least 100MB free hard disk space (200MB recommended)

� VGA display or better

� 2x CD-ROM or DVD drive for installing the printer software (4x or faster 
recommended)

� A shielded USB “AB” cable up to 6.5 feet (2 meters) long.
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Specifications

Printer specifications

Printing

Printing method On-demand ink jet

Nozzle configuration Black 48 nozzles
Color 45 nozzles (15 each: cyan, magenta, yellow)

Print direction Bidirectional with logic seeking

Input buffer 12KB

Mechanical

Paper feed method Friction

Paper path Sheet feeder, top entry

Sheet feeder capacity 100 sheets of 17 lb (65.8 g/m2) paper

Dimensions Storage Width: 16.7 inches (424 mm) 
Depth: 9.0 inches (229 mm)
Height: 6.8 inches (172 mm)

Printing Width: 16.7 inches (424 mm)
Depth: 18.1 inches (460 mm)
Height: 10.9 inches (277 mm)

Weight 5.47 lb (2.48 kg) without the ink cartridges

Electrical

Rated voltage (Universal Power 
Supply)

AC 100 - 240 V

Input voltage range* 90 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4 to 0.2 A

Power consumption Approximately 19 W (ISO10561 Letter Pattern)
Approximately 3.0 W Sleep mode
Approximately 2.7 W Power Off mode
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* Check the label on the back of the printer for your printer’s voltage.

** Stored in shipping container

* The figure given is based on continuous printing after ink replacement. The actual print capacity may vary.

** Ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

To ensure good results, use genuine EPSON cartridges and do not refill them. 
Other products may cause damage to your printer not covered by EPSON’s 
warranties.

Don’t use an ink cartridge if the date on the package has expired.

Environmental

Temperature Operation 50 to 95 °F (10 to 35 °C)
Storage** −4 to 140 °F (−20 to 60 °C) 

1 month at 104 °F (40 °C) 
Transit** –4 to 140 °F (–20 to 60 °C) 

120 hours at 140 °F (60 °C)

Humidity (without 
condensation)

Operation 20 to 80% RH
Storage** 5 to 85% RH

Safety Approvals

Safety standards UL 1950, CSA C22.2 No. 950 

EMC FCC part 15 subpart B class B
CSA C108.8 Class B

Ink cartridge specifications

Specification Black cartridge (T036120) Color cartridge (T037020)

Color(s) Black Cyan, Magenta, Yellow

Print capacity* 330 pages using ISO Letter 
Pattern 10561, 220 pages at 5% in 
calculation, except for the initial 
ink cartridge 

180 pages, 5% each CMY (total 15%) 
in calculation, except for initial ink 
cartridge

Cartridge life 2 years from production date (if unopened)
(within 6 months after opening package, at 77 °F [25 °C])

Storage temperature −4 to 104 °F (−20 to 40 °C) 
1 month at 104 °F (40 °C)

Transit temperature −22 to 140 °F (−30 to 60 °C)
1 month at 104 °F (40 °C); 120 hours at 140 °F (60 °C)

Freezing temperature** 3.2 °F (−16 °C) −0.4 °F (−18 °C)

Dimensions
(W × D × H)

0.78 × 2.08 × 1.52 inches 
(19.8 × 52.7 × 38.5 mm)

1.69 × 2.08 × 1.52  inches 
(42.9 × 52.7 × 38.5 mm)

Printer specifications (continued)
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Paper specifications

Plain Paper, Premium Bright White Paper, Ink Jet Paper

Size Letter (8.5 × 11 inches)
Half letter (5.5 × 8.5 inches)
Legal (8.5 × 14 inches)
Executive (7.25 × 10.5 inches)
A4 (8.3 × 11.7 inches)
A5 (5.8 × 8.27 inches)
User-defined: 

Width 3.5 to 9.5 inches
Length 3.5 to 44 inches

Paper types Plain bond paper or special paper distributed by EPSON

Thickness (for plain bond paper) 0.003 to 0.004 inch

Weight (for plain bond paper) 17 to 24 lb (64 to 90 g/m2)

Envelopes

Size No. 10 (4.13 × 9.5 inches)
DL (4.33 × 8.7 inches)
C6 (4.49 × 6.38 inches)
132 × 220 mm (5.2 × 8.7 inches)

Paper types Plain bond paper, airmail

Thickness 0.006 to 0.02 inch

Weight 12 to 20 lb (45 to 75 g/m2)

Ink Jet Cards

Size A6 (4.1 × 5.8 inches)

Paper types Special paper distributed by EPSON

Transparencies, Glossy Film, Photo Quality Glossy Paper, Glossy Photo Greeting Cards

Size Letter (8.5 × 11 inches)

Paper types Special paper distributed by EPSON

Self Adhesive Sheets

Size A4 (8.3 × 11.7 inches)

Paper types Special paper distributed by EPSON

Photo Stickers

Size A6 (4.1 × 5.8 inches) with 4 or 16 frames

Paper types Special paper distributed by EPSON
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Poor quality paper may reduce print quality and cause paper jams or other 
problems. If you encounter problems, switch to a higher grade paper.

Do not load curled or folded paper.

Avoid extremes in temperature or humidity when printing. Optimum printing 
temperature ranges from 55 to 77 °F, and optimum humidity ranges from 40 to 
60% RH.

Store EPSON Self-Adhesive Sheets under the following conditions: 59 to 86 °F, 
and 20 to 60% RH.

Matte Paper Heavyweight, Double-Sided Matte Paper

Size Letter (8.5 × 11 inches)
A4 (8.3 × 11.7 inches)

Paper types Special paper distributed by EPSON

Glossy Photo Paper, Photo Paper

Size Letter (8.5 × 11 inches)
4 × 6 inches
Panorama (8.3 × 23.4 inches)
A4 (8.3 × 11.7 inches)

Paper types Special paper distributed by EPSON

Paper specifications (continued)
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* When loading multiple sheets of EPSON Photo Quality Glossy Film, the minimum top margin is 1.2 inches 
(30.0 mm)

** When printing near the bottom margin, some colors may not print properly. If this occurs, try increasing the 
bottom margin.

Printable Area

Single Sheets, Ink Jet Cards, Envelopes

Minimum top margin (A)* 0.12 inch (3.0 mm)

Minimum left margin (B-L) 0.12 inch (3.0 mm)

Minimum right margin (B-R) 0.12 inch (3.0 mm)

Minimum bottom margin (C)** 0.54 inch (14.0 mm)

A

B-L B-R

C

Single sheets or ink jet cards Envelopes
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EPSON Ink Jet Papers and Ink Cartridges

Use EPSON paper and inks to get the same photo quality results that have earned EPSON’s printers all 
of their awards! EPSON papers are specially coated to work with EPSON’s quick drying inks. You’ll 
notice that when prints come out of your printer, you can immediately handle them. There is no 
drying time, no smearing or smudging, and your image is crisp and smooth. Here are the inks for your 
printer and just a few of EPSON’s papers:

Premium Bright White Paper

Premium Bright White Paper has a sleek, ultra-smooth surface, and 108+ 
brightness. This paper delivers crisp black text and vivid, colorful images. It’s 
perfect for everyday printing.

Premium Glossy Photo Paper 4 × 6

Here’s a water-resistant photographic-weight paper with a glossy finish for your photo 
keepsakes. It’s available in a variety of sizes, but you’ll find the 4 × 6 inch size is just 
right for your digital snapshots.

Glossy Photo Greeting Cards

Personalize and print top quality glossy cards using your favorite photos. 
Micro-perforated borders for edge-to-edge prints. Includes easy-to-use 
software.

EPSON Ink Cartridges 

For best results, always use genuine EPSON ink cartridges.

Black T036120 
Color T037020 

For more information on other EPSON products and fun project ideas, 
look for the EPSON Print LabSM Series at www.printlabseries.com.



How To Order EPSON Ink and Paper 55

How To Order EPSON Ink and Paper
To order EPSON ink cartridges, paper, and other printing media, contact 
your dealer or call EPSON at (800) 873-7766, or visit the EPSON Store 
at www.epsonstore.com (U.S. sales only). In Canada, please call (800) 
463-7766 for dealer referral.

EPSON Ink Cartridges

Black T036120 
Color T037020 

EPSON Papers

The availability of paper types varies by location.

Paper name Size Part number

EPSON Premium Bright White Paper Letter (8.5 x 11 inches) S041586

EPSON Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

A4 (8.3 x 11.7 inches) S041061

Legal (8.5 x 14 inches) S041067

EPSON High Quality Ink Jet Paper Letter (8.5 x 11 inches) S041111

A4 (8.3 x 11.7 inches) S041117

EPSON Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

EPSON Glossy Photo Paper 
(EPSON Photo Paper)

4 x 6 inches S041134/ S041671

Letter (8.5 x 11 inches) S041141/ S041649/
S041271/ S041272

A4 (8.3 x 11.7 inches) S041140

Panoramic (8.3 x 23 inches) S041145

EPSON Photo Stickers Kit (CD-ROM/paper)
EPSON Photo Stickers (refill)

A6 (4.1 x 5.8 inches) S041144-KIT

A6 (4.1 x 5.8 inches) S041144

EPSON Photo Quality Glossy Film Letter (8.5 x 11 inches) S041072

A4 (8.3 x 11.7 inches) S041071

A6 (4.1 x 5.8 inches) S041107

EPSON Ink Jet Transparencies Letter (8.5 x 11 inches) S041064

EPSON Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106

EPSON Photo Quality Glossy Paper Letter (8.5 x 11 inches) S041124

EPSON Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257

EPSON Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

EPSON Glossy Photo Greeting Card Kit Letter (8.5 x 11 inches) S041606
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Index

A

Accessories, 46
Aligning print head, 29 to 30
Authorization screen, Macintosh OS X, 45
Automatic mode, Macintosh, 15, 17

B

Background printing, 18
Banding, 38
Blank pages, 42
Blurry images, 39
Bright White Paper, 22, 54, 55
Buttons, 33

C

Cable, printer, 47, 48
Cancelling printing

Macintosh, 16, 19
Windows, 12

Characters, incorrect, 42
Checking printer, 35
Cleaning

print head, 23 to 25
printer, 30
sheets, 30

Color management, Macintosh, 15, 18
Color problems, 40, 53
ColorSync, 15, 18, 40
Controlling printing

Macintosh, 16, 19
Windows, 12

Copies setting, 15, 17

D

Default settings, Windows, 12
Documentation, 5 to 6
Double-Sided Matte Paper, 22, 52, 55
Draft setting, 10

E

Economy setting, 15, 18
Electrical specifications, 49
Envelopes

minimum margins, 53
printing on, 20 to 21
specifications, 51

EPSON
accessories, 46
help, 46
papers, 22, 54, 55
Print Lab Series, 54
Store, 26, 46

F

Faint images, 39
Fine setting, 15, 18
Flip Horizontal setting, 42

G

Gamma setting, 15, 40
Glossy Photo Greeting Cards, 22, 51, 54, 55
Glossy Photo Paper, 22, 52, 54, 55
Grainy prints, 40
Greeting cards, 22, 55
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H

Head Cleaning utility, 23 to 24
Help, EPSON, 46

I

ICM, 11, 40
Incorrect characters, 42
Incorrect colors, 40
Incorrect margins, 42
Ink cartridge

cartridge life, 50
level of ink in, 12, 18, 25 to 26
ordering, 25 to 26, 46, 55
print capacity, 50
replacing, 25 to 26
safety instructions, 26
specifications, 50

Ink jet cards
minimum margins, 53
ordering, 55
specifications, 51

Ink Jet Transparencies, 22, 55
Ink level, checking

Macintosh, 18, 26
Windows, 12, 25

Ink Monitor, 25
Ink setting, 15, 18
Installation problems, 36 to 37
Inverted image, 42

J

Jams, paper, 41, 52

L

Layout settings, Macintosh, 15, 18
Letterhead, 8
Lights, 33 to 34

M

Macintosh
printing with OS 8.5.1 to 9.x, 17 to 19
printing with OS X, 13 to 16
reinstalling software, 44 to 45
system requirements, 48

Maintaining printer, 23 to 30
Margins

incorrect, 42
minimum, 53

Matte Paper Heavyweight, 22, 52, 55
Media Type setting, Macintosh, 15, 18, 22
Mirror images, 42
Monitoring ink level

Macintosh, 18, 26
Windows, 12, 25

Moving printer, 31

N

Noise, printer, 38
Normal setting, 15, 18
Nozzle Check, 24 to 25

P

Page Setup, Macintosh, 13, 17
Paper

EPSON, 22, 55
feeding problems, 41
loading, 8
ordering, 55
specifications, 51 to 53

Paper Type setting, Windows, 11, 22
Photo Enhance setting, 11, 18, 40
Photo Paper, 22, 52, 55
Photo Quality Ink Jet Paper, 22, 55
Photo RPM setting, 10, 15, 18, 40
Photo setting, 10, 15, 18
Photo Stickers, 8, 22, 51, 55
Preferences window, 10
Premium Bright White Paper, 22, 54, 55
Preprinted paper, 8
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Previewing printout, 11, 18, 21
Print dialog box, Macintosh, 14, 17
Print head

aligning, 29 to 30
cleaning, 23 to 25

Print quality problems, 38 to 40
Print Quality settings, 15, 18
Print Settings dialog box, Macintosh, 14
Printable area, 53
Printer

cable, 47, 48
check, 35
cleaning, 30
maintaining, 23 to 30
noise, 38
parts, 33
problems, 34, 37 to 38
transporting, 31

Printing
controlling, 12, 16, 19
on envelopes, 20 to 21
slow, 38
with Macintosh, 13 to 19
with Windows, 9 to 12

Problems
installing software, 36 to 37
miscellaneous, 42
paper feeding, 41, 52
print quality, 38 to 40
printer, 37 to 38

Progress meter, 12, 16, 19
Properties window, 10

Q

Quality Type setting, 10
Quality/Speed setting, 15, 18

R

Reinstalling software, 43 to 45
Replacing ink cartridge, 25 to 26
Requirements, system, 47, 48
Reverse Order setting, 11

S

Safety approvals, 50
Self adhesive sheets, 8, 22, 51, 52
Slow printing, 38
Software

problems, solving, 36 to 37
reinstalling, 43 to 45

SoundAdvice, 46
Specifications

electrical, 49
ink cartridge, 50
paper, 51 to 53
printer, 49 to 50

System requirements, 47 to 48

T

Text & Image setting, 10
Text setting, 10
Thickness, paper, 51
Transparencies, 22, 51, 55
Transporting printer, 31
Troubleshooting, 32 to 42

U

Uninstalling software, 43 to 45
USB

problems, 37
requirements, 47, 48

Utilities
Head Cleaning, 23 to 24
Nozzle Check, 25
Print Head Alignment, 29 to 30
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W

Weight, paper, 51
Windows

default settings, 12
printing with, 9 to 12
Quality Type, 10
reinstalling software, 43
system requirements, 47

World Wide Web, 46
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